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User guide 

 

AIT1000© proAIS Application  
 
Note 
 
proAIS is intended as a dealer application for programming and diagnostic testing of the AIT1000 
 
It can also be used with an on board PC for real time data viewing 

 



DIGITAL YACHT LTD  AIT 1000 Installation & Operation Manual  

 

 

GENERAL WARNINGS 

All marine Automatic Identification System (AIS) units utilise a satellite based system such as the Global Positioning Satellite 
(GPS) network or the Global Navigation Satellite System (GLONASS) network to determine position. The accuracy of these 
networks is variable and is affected by factors such as the antenna positioning, how many satellites are used to determine a 
position and how long satellite information has been received for. It is desirable wherever possible therefore to verify both your 
vessels AIS derived position data and other vessels AIS derived position data with visual or radar based observations.  

The proAIS application is intended for use as an installation and configuration tool. The application is not a navigation tool 
and should not be used as such.  

 

LICENSING 

IMPORTANT: In most countries the operation of an AIS unit is included under the vessels marine VHF licence provisions. The 
vessel on to which the AIS unit is to installed must therefore possess a current VHF radiotelephone licence which lists the AIS 
system and the vessel Call Sign and MMSI number. Please contact the relevant authority in your country for more information. 
In accordance with a policy of continual development and product improvement the AIT1000 hardware and software may be 
upgraded from time to time and future versions of the AIT1000 may therefore not correspond exactly with this manual. When 
necessary upgrades to the product will be accompanied by updates or addenda to this manual. Please take time to read this 
manual carefully and to understand its contents fully so that you can install and operate your AIS system correctly. 

Information contained in this manual is liable to change without notice. Digital Yacht Ltd disclaims any liability for consequences 
arising from omissions or inaccuracies in this manual and any other documentation provided with this product. 

 

DISCLAIMER 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF 
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

 

This software uses components and source code developed by other companies or groups. 

 

Microsoft .Net Framework V2.0: Copyright © 2005 Microsoft Corporation 

 

ZedGraph Graphing component dll (http://zedgraph.org): Provided under the GNU Lesser General Public License 

 

 

  

All trademarks mentioned in this document are the property of their respective owners. 

Copyright © 2008, Digital Yacht Ltd 
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Installation guide 
Prerequisites 
The proAIS application is designed to operate with Microsoft Windows 2000, XP, Vista and Windows 7. Recommended 
minimum system requirements are: 

·  Microsoft Windows XP SP2 

·  Display resolution of at least 1024 x 768 
·  At least one RS232 serial port (or USB to serial converter already  installed*) 

 

*If you are using a USB to serial converter please ensure this is fully installed before proceeding. 

This software uses the Microsoft .Net Framework V2.0. The framework will be automatically installed during setup if not already 
present on the system. 

 

Setup 
1. Insert the installation CD and locate the Setup.exe file. 
2. Double click the Setup.exe file to begin the installation.  
3. Follow on screen prompts to install the .Net framework if required 
4. When the security warning below is displayed, select 'Install' 

 

5. The application will install and launch automatically 
6. A Start Menu folder and shortcut will be created with the name 'proAIS'. This short cut should be used to re-launch the 

application as required 

Removal 
The proAIS application can be removed at any time via the windows Control Panel 'Add or Remove Programs' tool. 
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User guide 
AIS Connection 

1. Launch the proAIS application by navigating to the 'proAIS' shortcut on the Start Menu. 
2. The initial application screen will appear as shown below (exact screen display depends on version installed) 

 

 

 

 
3. The application requires a serial connection to an AIT1000© transponder. Connect the transponder to an available 

serial port.  The application will not function correctly unless an AIT1000 is powered up and connected to a serial port 
4. Select the serial port from the drop down menu, then click 'Connect': 
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5. Once a connection is established the application is ready to use. Connection status is indicated at the bottom left of the 
application window: 

 

 
6. The functions of proAIS are arranged in a series of tabs. Each tab contains information relating to a particular aspect of 

the connected AIS transponder. Depending on the version of proAIS installed not all tabs shown below may be visible. 

 

 

 

·  Configuration tab 
o Displays the 'Static data' for the connected AIS transponder. This includes the vessel's name, call 

sign, MMSI number and other fixed information 
o Allows editing of the static data 

 

·  GPS Status tab 
o Shows the status of the internal GPS receiver, including position fix data and satellite signal strength 

graph 

 

·  Diagnostics tab 
o Shows the status of key system diagnostics. Used to troubleshoot installation of the transponder and 

verify correct operation. 

·  Other Vessels tab 
o Shows information about other vessels in the area received from the AIS transponder 
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·  Messages tab 
o Displays safety related messages received from other AIS equipped vessels. 

·  Options tab 
o Provides access to software controlled features of the AIT1000 AIS transponder. 

 

·  Software update tab 
o Provides facilities to upgrade the transponder software from an update file. 

 

·  Serial Data tab 
o Shows the raw NMEA serial data being generated by the transponder. Provides a facility to log this 

data to a file for later analysis. 
o Allows NMEA commands to be sent to the transponder 

 

 

Subsequent sections describe the functions of each tab in more detail. 
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Menu Bar 
The menu bar provides basic program options.  

Under the 'File' menu the 'Open log file' option allows playback of a log file previously recorded using proAIS. A log file can be 
recorded using the tools provided on the 'Serial Data' tab. During log file playback only data recorded in the log is available and 
most buttons in the application will be inoperative.  

The 'Open log file' option is not available whilst a serial connection is made. Please disconnect from the AIS transponder to 
enable this option. 

 

 

 

Under the 'Options' menu item checking 'Beep on AIS Transmission' will cause the PC to emit a sound every time the 
connected AIS unit transmits. 

The 'Force connection' option is used for diagnosing connection issues and should be left unselected. This feature should be 
used under guidance from your technical support contact. 

 

The Help -> About menu item displays the program splash screen and version information. 
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Static Data Tab 
This tab shows the current configuration of the AIS transponder and allows the configuration to be programmed during 
installation into a vessel. 

 

When an un-configured AIS transponder is connected for the first time the display will be similar to that shown below: 

 

 

 

Configuring the transponder 

To configure the transponder all of the data fields must be completed and saved to the AIS.  

i  CAUTION: 

For security reasons the MMSI of the vessel cannot be changed once programmed. Do not programme the 
MMSI unless you are certain you have the correct information. Please check the numbe r entered carefully. If 
the MMSI programmed is incorrect the AIS transponder will need to be returned to the suppli er for factory 
reset.   
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Configuring the transponder continued... 

Enter the vessels information in the appropriate box: 

·  Ship's name - enter the name of the vessel (20 characters maximum) 

·  Call Sign - enter the vessel's radio call sign (7 characters maximum) 

·  MMSI number  - enter the vessel's Maritime Mobile Service Identity number 

·  Enter the vessels dimensions as follows 
o Dimension A  - distance from bows to GPS antenna location to the nearest meter 
o Dimension B - distance from the GPS antenna location to the stern to the nearest meter 
o Dimension C - distance from the port side to the GPS antenna location to the nearest meter 
o Dimension D - distance from the GPS antenna to the starboard side to the nearest meter 

·  Select the most appropriate vessel type from the drop down menu. 

·  An example showing typical data values is shown below; 
 

 

i  CAUTION: 

If no MMSI is entered (MMSI is set to 000000000) then the AIS transponder will op erate in receive only mode. 
The vessels own position will not be transmitted. An MMSI must be entered to allo w the AIS transponder to 
transmit its own position to other vessels. 

 

If you are connecting another NMEA0183 device to the AIT1000; such as a compass and wish this data to be multiplexed 
(merged) with the AIS data output by the AIT1000, then set the NMEA input baud rate to 4800 Baud. It is best to leave all other 
baud rates at 38,400 baud which is the standard high speed data rate used by AIS. 
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If you have connected a "Remote Switch" (push button or toggle) to the AIT1000, you will need to select the switch function you 
require before the remote switch can be used.  

·  Select the "Press switch to send Safety Related Message" option if you want to configure the unit to transmit an AIS 
"Safety Related Message" when the switch is pressed. The switch must be pressed for two seconds to initiate this 
message which is broadcast with the vessels MMSI and the text "MAYDAY MAYDAY". Please note this should not be 
considered as a primary means of distress call. Only works with a push button type switch. 

·  Select the "Make external switch to enable silent mode" option if you will use an external toggle switch for "Silent 
mode" control. Whilst the switch is closed the transmitter is disabled and other vessels will not receive your position via 
AIS. The receiver remains operational. The amber LED will illuminate to indicate the transmitter is disabled. 

·  Select the "Press switch to toggle silent mode" if you will use a push button switch to toggle "Silent mode" on and off. 
The switch must be held for two seconds to toggle the transmitter off or on. When the transmitter is disabled other 
vessels will not receive your position via AIS. The receiver remains operational. The amber LED will illuminate to 
indicate this transmitter is disabled. 

·  Select the "Switch has no function" option if you will not use a switch to control "Silent mode" or transmission of a 
Safety Related Message. 

When you have entered all of the vessel's data click the 'Save static data to AIS' button to  programme this 
configuration into the AIS transponder : 

 

 

·  A warning will be displayed asking you to verify the MMSI number. Please check the number displayed is correct 
before proceeding. If the number is incorrect click the 'No' button to cancel programming of the MMSI: 

 

 

·  Click the 'Yes' button if the MMSI is correct. If you select 'No' the static data will not be updated and you can correct the 
MMIS before proceeding. 

·  The static data tab will be updated to show the newly programmed vessel information. The MMSI number will be 
displayed with a grey background to indicate that it has been programmed and cannot be changed. 
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GPS Status tab 
This tab shows the status of the internal GPS receiver. If the GPS receiver has position fix then the current position, speed and 
course are shown. A bar chart of satellite signal strength is also provided. 

 

Satellite signal strength bars are shown in green for satellites that are currently being used for navigation. Blue signal strength 
bars are used to show satellites not currently being used for navigation.  It is normal for the graph to display a combination of 
green and blue bars. 

The information on this tab is intended for use during installation of the AIS transponder in order to verify connection of the GPS 
antenna.  
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Diagnostics tab 
The diagnostics tab shows key status information from the AIS transponder. This information can be used to quickly verify that 
the transponder has been installed correctly and is operational. 

 

 
AIS Transponder Status 

·  A tick next to the items in this area indicates correct operation. 

·  If a red cross is shown then some action may be required: 

o Transponder MMSI valid has a red cross - check the MMSI of the unit is configured by selecting the 'Static 
Data' tab and verifying that a valid MMSI has been entered. If the MMSI is 000000000 then it has not been 
programmed. 

o GPS position fix has a red cross - the GPS has not acquired a position fix. Please allow up to 5 minutes for a 
fix to be acquired. If the red cross is still present check the GPS antenna is correctly connected and has a 
clear view of the sky. 

o AIS has transmitted a position report has a red cross - the unit has not yet transmitted its position. Please 
allow up to 5 minutes after GPS fix has been acquired for the green tick to appear. If the red cross is still 
present after this time please refer to the active alarms section below. The AIS will not transmit unless it has 
acquired GPS fix and has a valid MMSI programmed 

o AIS has received a position report - a position report from another vessel has been received. If there is no 
other AIS equipped vessel in the area the red cross will remain against this item. If other AIS equipped 
vessels are present and the red cross remains please check the VHF antenna connections. 

AIS Transponder Active Alarms 

Any active alarm messages generated by the AIS unit are shown here 
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·  Note that alarms may take up to 1 minute to clear from this display once their source has been corrected 

·  It is normal for GPS related alarms to be displayed when the AIS is first switched on. These alarms will clear once GPS 
position fix is acquired. 

·  Please refer to the troubleshooting section for a description of each alarm message 
 

AIS Transponder Information 

This section shows technical information about the connected AIS transponder including software and firmware version 
information. Depending on the AIS software version the ability to display the GPS firmware version may not be present. If shown 
clicking the 'Get version' button will retrieve the GPS firmware version. Please note that this operation may result in a temporary 
loss of GPS fix. 

 

LED Status 

This section mirrors the LED display on the front of the AIS transponder and is useful when the unit is installed in a location 
where the physical LEDs are not easily visible. 

 

Internal Data 

This section provides internal diagnostics data from you’re AIS transponder. Your dealer may request this information if 
diagnosing any problems with your installation.  

Supply voltage is a very important factor in the correct operation of the AIT1000, this value should always be above 10.8v 
otherwise the AIT1000 will start transmitting alarm messages as correct operation cannot be guaranteed. If this value is low, 
ensure that your 12v supply is producing enough voltage and that there is not excessive voltage drop in the power cables. 

The RRSI (Received Signal Strength Indicator) and TX Power values are good indicators of how well your antenna is receiving 
and sending data.  

·  RRSI values should be between 20 and 100 - if they are continually lower than this there may be a problem with the 
antenna or AIT1000 receiver 

·  TX Forward Power should be as high as possible, typically between 130-150   

·  TX Reverse Power should be as low as possible, typically between 10-30   

 

Statistics 

This section shows the number of AIS messages received and transmitted on each of the AIS channels. You can use this 
information to verify that the transponder is successfully receiving and transmitting data when other AIS equipped vessels are in 
range. 
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Serial data tab 
This tab shows the raw NMEA 0183 serial data being output by the AIS. A typical display is shown below: 

 

·  NMEA command sentences can be sent to the unit by entering them in the lower text box and clicking the 'Send' 
button. proAIS will calculate and append the NMEA checksum to the sentence if the "Add Checksum" check box is 
checked. In this case enter a NMEA sentence without including the asterisk that precedes the checksum. 

·  Serial data can be logged to a file by clicking the 'Log to file' button and entering a file name and location in the dialog 
box.  

o Logging to file will continue if other tabs are selected after logging has been started 
o Logging to file will cease when the 'Stop logging' button is clicked 

·  The serial data display can be paused by clicking the pause button at the bottom right hand side of the data window. 
Clicking the button a second time will resume output of the live serial data. 

·  Transmitted AIVDO messages are indented for easy identification 
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Software update tab 
This tab provides the facility to update the AIS transponder's internal software. 

 

i  CAUTION: 

Only perform a software update using an update file intended for use with the AIT1000© product. 

Do not interrupt the power to the unit or disconnect from the PC during the update process unle ss instructed 
to do so by the proAIS application. 

 

 
1. Click the 'Select update file' button and navigate to the update file. This will have the extension .hex 
2. Click the 'Start update button'  
3. Follow the instructions provided underneath the update progress bar.  
4. Depending on the AIS software version you may be requested to power cycle the unit at two points in the process. 

Turn the power supply to the AIS off and back on again at these requests. Do not disconnect the serial connection to 
the PC. 

5. Once the 'Update completed' is displayed the AIS is ready for use 
6. Please verify the information shown on the static data tab is correct after any software update. 
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Other vessels tab 
This tab shows information received from other AIS equipped vessels in the area. 

·  The MMSI of each vessel is shown.  
o Vessels equipped with Class A AIS have the MMSI displayed in black text.  
o Vessels equipped with Class B AIS have the MMSI shown in blue text 

·  The name and call sign of each vessel is shown 
o Due to the way AIS operates this information may take some time to appear 

·  The speed in knots, course in degrees, decimal latitude and longitude are shown for each vessel 

·  The approximate distance to each vessel is shown when the connected unit has a GPS fix. Please note that this is an 
approximate  distance for indication only. 

·  The class of the AIS equipment on each vessel is displayed as A or B 

·  Columns can be sorted into ascending or descending order by clicking on the column heading. 
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Messages tab  
This tab displays safety related messages received from other AIS equipped vessels in the area. The tab displays two message 
types: 

·  Addressed Safety Related Message (VDL Message #12) 

·  Broadcast Safety Related Message (VDL Message #14) 

The UTC time the message was received, along with the MMSI of the sender will be displayed along with the text contents of 
each message. 
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Options tab 
The Options tab provides access to software controlled features of the AIT1000 transponder. Depending on the AIS software 
version the following commands may be available: 

 

·  Silent mode 
o Buttons to enter / exit silent mode. In Silent mode the transmitter is disabled and no position reports are 

transmitted by the unit. Other AIS users will be unaware of your position in this mode so it should be used with 
caution and only where allowed by local regulations. 

·  GPS output options 
o By default the AIS transponder will output its current GPS position data every four seconds via the RS232 and 

NMEA serial interfaces. This information is sent using the GPRMC sentence and can be used to provide your 
vessels GPS position to a chart plotter connected to the unit. A higher position update rate (once per second) 
is available as an option and will result in a more accurate display of your vessels position, speed and course 
on a connected chart plotter. To use this option select the "Output GPS data every second" option and click 
'Update'. 
 

·  WAAS / EGNOS 
o To gain the benefit of improved GPS position accuracy by using the WAAS / EGNOS differential GPS 

services, enable this feature and click 'Update'. 

·  Alarm output options 
o By default the AIS transponder will only output the status of active alarms using AIALR sentences. The unit 

can optionally be configured to output the status of all alarms every minute using the radio buttons. The 
'Update' button should be clicked to send new settings to the AIS transponder. 

 

 


